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Overview 

This Technician’s Installation Packet (Tech Pack) outlines the responsibilities of the local 
technician, and how support can assist. This document covers recommended hardware, 
network, and software configurations. It also contains information on configuring WinOMS, a 
Sensei product, as well as migrating the data to a new server, maintaining, and backing up data 
and necessary files for WinOMS. 

WinOMS is a critical systems application that must be running every day with as little down time 
as possible. In addition to the application, the hardware is critical to ensuring the stability of an 
automated practice management system. Our hardware recommendations follow what has 
been tested. Carestream Dental is only able to test WinOMS in a limited number of 
environments. WinOMS support will work with you as best as we can if you are not following our 
recommendations, but we will be limited in modifications we can make to get WinOMS working 
in environments that do not meet the requirements listed in the current Systems 
Requirements. 

Carefully read and follow the installation instructions in the Installation Guide, and 
recommendations contained within this Technician’s Installation Guide. If you have any 
questions, contact WinOMS support. 

Technician Acknowledgement 

The local technician is fully responsible for the configuration, installation, and maintenance of 
the client's computer network. Our company does not support the installed network or its related 
issues, including printer installations or operations. 

The local technician is fully responsible for making sure the hardware is configured and the 
client is trained to save and restore a backup of the WinOMS data and all necessary files for 
WinOMS. Since there are many types of backup programs, WinOMS support does not train 
offices on configuring the backup system or restoring a database. If an office must send data to 
WinOMS support for in-house analysis, send backups on external hard drives, flash media, or 
internet transfers. No other forms of backup media are accepted for data analysis. Addendums 
to installation documents will be made as necessary. 

The local technician is fully responsible for the support and maintenance of the client's computer 
network system. Give your clients your contact information and specific instructions to contact 
you first for system-related problems. Any questions about optimizing the network environment 
for use with WinOMS products are welcome. It is recommended that you be familiar with the 
client’s Windows operating system and carry an MCSE (Microsoft Certified Systems Engineer) 
certification or equivalent on staff. 

WinOMS representatives are highly trained and capable of assisting you to ensure a smooth 
software/hardware installation and systems upgrade. When contacting support, be sure to have 
the client’s account or phone number ready. 

Questions can be emailed directly to oralsurgerysupport@csdental.com or call support at 
800.275.4637. 

  

mailto:oralsurgerysupport@csdental.com
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System Requirements, Installation and Configuration 

Before installing WinOMS or migrating the data, review the following items in the Resource 
Library: 

• System Requirements – Review before proceeding to ensure the hardware meets or 

exceeds the current requirements. 

o Locally Hosted or Shared Server 

▪ Locally Hosted or Shared Server System Requirements Version 10.0 

▪ Locally Hosted or Shared Server System Requirements Version 9.7 

▪ Locally Hosted or Shared Server System Requirements Version 9.6 

o WinOMS Cloud 

▪ WinOMS Cloud System Requirements Version 10.0 

▪ WinOMS Cloud System Requirements Version 9.7 

• Configuration Guide – Review the current configuration recommendations. 

• Installation Guide – Follow the steps to perform an upgrade or new installation. 

Licensing and Registration 

Before removing any software from the old server, copy the contents of the PWSvr folder which 
contains the license file. 

Notes: 

• This PWSVR folder is normally installed within the WinOMSCS folder on the data 

server. This location may vary if the office is using Carestream Dental Oral Imaging. 

• Install the license file on the new server before installing the software on the 

workstations. 

• If you do not have a current copy of the license file, contact support. The support team 

can either send a copy via email or connect to the server and upload a copy. 

Installing the License File 

When a prompt to install the license file is displayed while installing or opening WinOMS, do the 
following: 

1. Browse to the location of the saved PWSvr file. 

2. Select the file. 

3. Click OK. 

Registering the Software 

When a prompt to register the software is displayed while installing or opening WinOMS, 
register the software using one of the following methods: 

• Register online via the internet 

• Contact support by phone 

https://gosensei.com/pages/resource-library
https://gosensei.com/pages/resource-library
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/WinOMS_10.0.3_CR_SystemRequirements_4d91d499-0baa-4d3a-8f82-909d0651d96e.pdf?v=1692043290
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/WinOMS_9.7_CR_SystemRequirements.pdf?v=1691634780
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/WinOMS_9.6_System_Requirements.pdf?v=1691634780
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/WinOMS_10.0.3_HostedSystemRequirements.pdf?v=1691634780
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/WinOMS_9.7_HostedSystemRequirements.pdf?v=1691634780
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Note: If you are unable to register the software at this time, click Cancel to continue with the 
update. You have seven days to register the product. 

To Register via the Internet 

1. Select Automatically via the Internet. 

2. Click OK. The Registration Code window is displayed while the code is generated. 

3. After the registration code is obtained, the Installation Complete window is displayed. 

4. Click Finish. 

Note: If you have registered the software more than three times, you will be required to 

contact support to receive a registration code. 

To Register by Phone 

1. Select Contact support by telephone. 

2. Click OK. 

3. Contact support using one of the following methods: 

o Call 800.275.4637. 

o Email oralsurgerysupport@csdental.com. 

4. Provide the Customer ID and Hardware ID information from the Registration window 

when contacting support. These numbers are used to generate the Registration Code. 

5. Type the registration code in the Registration Code field. 

Note: Use capital letters when typing the registration code. 

6. Click OK. The Installation Complete window is displayed. 

7. Click Finish. 

Backup and Restore Recommendations 

This section covers recommendations for configuring a backup routine for WinOMS data and 

related files. When setting up the backup routine, review the following sections in the WinOMS 

Configuration Guide in the Resource Library for more information. 

• Backing Up Data 

• Using a Backup Checklist 

• Establishing a Backup Routine 

• Managing Files and Backup Media 

The WinOMS practice is responsible for maintaining backups of the WinOMS data. We 

recommended backing up the entire WinOMSCS folder daily to ensure the database and all 

other items pertinent to running WinOMS are backed up. Work with your hardware vendor to 

create and maintain a backup routine that is specific to your practice. 

  

mailto:oralsurgerysupport@csdental.com
https://gosensei.com/pages/resource-library
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On-premise WinOMS data is stored on the server in the following folder: 

• (ServerDataDrive):\WinOMSCS\Data 

Note: If the data was installed in a location other than the default directory, configure the 

backup system to back up the actual data location. 

Configuring the Backup for WinOMS v9.7 and Older – Sybase 

Important: Before installing or updating WinOMS, we recommend you back up any important 

data and the entire WinOMSCS folder on the server which includes the data files. 

The Sybase data files are: 

• mdsdb.db 

• mdsdb.log 

• mdsdb.bak 

The network server must be configured to automatically stop and start the Sybase database 

service as part of the backup process. If the database service is not stopped, the database will 

not be backed up successfully. WinOMS does not support live backups. The database can be 

stopped and started by using Sybase Central or by using net stop and net start commands. 

We recommend using net stop and net start commands. 

• Before the backup, stop the database service using: Net stop ASANYs_SQLMDS 

• After the backup, start the database service using: Net start ASANY’s_SQLMDS 

Note: In these examples, the name of the database service is SQLMDS. Replace SQLMDS 

with the correct service name if it is different for the practice. 

Depending on how the local technician configures the backup system, these commands may be 

used in a variety of ways. The commands can be contained in a batch file on the server or may 

be included as additional commands the backup software automatically executes before and 

after the backup occurs. We recommend automating the process by using the commands within 

batch files and using the Windows at command to run the batch files. 

Examples: 

• at 23:59/every:m,t,w,th,f c:\Backup\Dbstop.bat 

• at 05:00/every:t,w,th,f,s c:\Backup\Dbstart.bat 

To summarize: 

1. Install and configure the backup software. 

2. Create batch files for stopping and starting the database. 

3. Use at commands to schedule the batch files to stop the database before the backup is 
scheduled to run and start the database before the office opens in the morning. 

4. Do a test run to ensure the batch files work and the backup runs successfully. 

5. Restore from a backup to ensure the backup was completed correctly. 
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Configuring the Backup for WinOMS v10 and Higher – SQL 

Important: MSSQL backup and database maintenance plans are not services provided by 

WinOMS support. We recommend stopping SQL services prior to making a backup. WinOMS 

does not support live backups. 

The MSSQL data files are: 

• mdsdb.mdf 

• mdsb_log.ldf 

WinOMS v10.0 includes a command line process to facilitate backing up the Microsoft SQL 

database through the CSToolkit. All users must be logged out of WinOMS before executing the 

backup process. The backup file (mdsdb.bak) is created in a dated and timed subdirectory of 

the backup location, c:\temp by default, unless another location is specified in the command 

line. The naming convention for the directory is MM-DD-YYYY-HH-MM-SS. 

Example: The command cstoolkit/backup c:\backupfolder initiated on January 1, 2024, at 

1:30 PM would generate a file named C:/backupfolder/01-01-2024-13-30-00/mdsdb.bak. This 

process will restart the database service after the backup is created. 

To back up the v10 database from the Windows command line: 

1. Open the Command Prompt from the Windows Start menu. 

2. Navigate to the directory containing the WinOMS installation. 

o WinOMS is usually installed at C:\WinOMSCS or D:\WinOMSCS. 

Note: If the data was installed in a location other than the default directory, configure the 

backup system to back up the actual data location. 

3. Enter cstoolkit/backup to initiate the backup to the default directory, c:\temp. 

o To specify a different location, add the desired directory to the end of the command. 

Example: The command cstoolkit/backup d:\WOMSbak will store the backup files 

in the d:\WOMSbak directory. 

The backup process creates a log file, backup.log, in either the default or specified backup 

location. The log file contains details of the backup process. 

Examples of successful backup notes in the log file: 

• Processed 52888 pages for database 'mdsdb', file 'mdsdb' on file 1. 

• Processed 2 pages for database 'mdsdb', file 'mdsdb_log' on file 1. 

• BACKUP DATABASE successfully processed 52890 pages in 4.611 seconds (89.610 

MB/sec). 

Warning: The .bak file created during this process could technically be used to restore the SQL 

server to view or query the data. We do not recommend this type of restore as it would not allow 

users to log into WinOMS or future updates to install. Should the office need to restore data, 

contact support for assistance. 



 

Page 6 

WinOMS Tech Pack 

OL700-01 

WinOMS Installer Files – v10 or Higher 

Beginning with version 10.0, the WinOMS Installer is available for download via the Dental 

Practice Management Software Download Service. 

1. Save the WinOMS and SQL Server Installer files to the server. 

2. Follow the procedures in this document to install or update WinOMS. 

Downloading the Installer Files 

1. On the server, go to https://softwaredownload.csdental.com/en-US/. The Dental 

Practice Management Software Download Service login window is displayed. 

2. Enter the Customer ID and Zip Code. 

3. Click Submit. The installer file downloads are displayed, along with instructions. If the 

files needed are not available, please contact Support. 

Note: Server computers need both the WinOMS update and SQL files. Workstation 

computers need only the WinOMS file. 

4. For each file, click Download, and save the file to the default download location. 

Note: If the downloaded file is zipped (.zip), right-click and select Extract All. 

Installation Recommendations 

Important: Before installing or updating WinOMS, we recommend you back up any important 

data and the entire WinOMSCS folder on the server which includes the data files. 

• Purchase only fully tested devices listed in the System Requirements. 

o While some non-recommended hardware performs acceptably with WinOMS, it 

remains the responsibility of the hardware technician to maintain the performance of 

the non-recommended hardware in question. If you are unsure as to whether a 

particular device is compatible with WinOMS, email 

oralsurgerysupport@csdental.com or call support at 800.275.4637. 

• Review the enhancement features for the new version in the Release Notes and What’s 

New section of the Online Help Guide in the Resource Library. 

• WinOMS v10 requires an MSSQL license before installation. If the office does not have 

an MSSQL license, contact our sales department at 800.944.6365. 

• When replacing the server, make sure the workstations can browse via UNC path to the 

new server. 

o Any password prompts must be turned off or server credentials must be entered to 

allow the workstations to connect to the server. 

• The WinOMSCS folder must be shared with full control permissions and file security 

must be set for Everyone with Full Control. 

https://softwaredownload.csdental.com/en-US/
mailto:oralsurgerysupport@csdental.com
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• Set the screen resolution to 1280x1024 or higher to properly display information in 

WinOMS. If using the Electronic Medical Records (EMR) feature, the recommended 

resolution is 1440x900. 

• Configure the hardware and software firewall to open the following ports internally: 

o For offices using Sybase, open the 2638 port. 

o For offices using MSSQL, open the 1434, 1435, and 1436 ports. 

• For remote WinOMS login, a firewall exception is required for the dbsrv9.exe. The file 

can be located in either of the following locations depending on the operating system: 

o C:\Program Files\Sybase\SQL Anywhere 9\win32\dbsrv9.exe 

o C:\Program Files\Sybase\SQL Anywhere 9\x64\dbsrv9.exe 

Note: A firewall exception is also required for mdcs.exe. 

o File Location: Root of the WinOMSCS folder 

• The update process updates existing files, adds new files, and removes outdated 

WinOMS files on the server. For v9.x or earlier, the SQLMDS service must be running 

during the update. The process also updates the Sybase Database Engine. The 

SQLMDS services must be running to start the update. 

• A server installation creates and installs the database engine that runs the database and 

the server portion of the practice management software that connects to the database. 

• WinOMS updates must be installed on the server before the update is run on each 

workstation in the network. Workstation updates can be run simultaneously. When a 

workstation is updated, a user can log into WinOMS if needed while other workstations 

are being updated. 

WinOMS Version 9.x Sybase Instructions 

Important: Before installing or updating WinOMS, we recommend you back up any important 

data and the entire WinOMSCS folder on the server which includes the data files. 

The following instructions cover the processes for first-time WinOMS installations and updating 

existing installations for Sybase versions of WinOMS, versions 9.7 or older. Read this document 

carefully before proceeding. 

Sybase version 9 is installed on the server from the WinOMS disk or ISO file. 

• If updating existing software, follow the steps in the Updating the Server – v9.x – 

Sybase and Updating Workstations – v9.x – Sybase sections. 

• If performing a new installation, follow the steps in the Installing on a New Server – v9.x 

– Sybase and Installing on a Workstation – v9.x – Sybase sections. 
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Updating the Server – v9.x 

Before beginning the update, verify the WinOMSCS folder on the server is shared with full read 

and write permissions.  

Notes: 

• If you are upgrading from a version of WinOMS prior to v9.x, the Sybase Client Drivers 

window is displayed during the client installation. Follow the instructions on the window. 

The steps are in the Installing on a Server – v9.x section. 

• The Sybase Services cannot be running during a new server install and only installs the 

current version from the Server Side – Install selection. The Sybase Services must be 

running when selecting a Server Side – Update and after the install is completed. 

To update WinOMS on the server: 

1. Shut down all workstations in the network and close all programs on the server. All users 

must be logged out of WinOMS. 

2. Ensure the Sybase database service is running. 

3. Navigate to the location of the ISO file uploaded by support. 

4. Right-click the ISO file and select Mount. 

5. Right-click Setup.exe and select Run as administrator. 

Notes: 

• If you have a zipped file of the disk instead of the ISO file, unzip the file. Map a path 

to the Setup.exe file. Right-click Setup.exe and select Run as administrator. 

• The installer checks the computer for Microsoft .NET Framework 3.5 Service Pack 

1 (SP1). 

o If the files are present, the installation proceeds as usual. 

o If the files are not present, the installation of SP1 proceeds automatically. After 

SP1 is installed, a prompt to restart the computer is displayed. Restart the 

computer. If the installation does not continue after the restart, repeat step 5. 

o After SP1 is confirmed or installed, the Select Component window is displayed. 
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6. Select Server Side - Update. 

7. Click Next. The Server Data Drive window is displayed. 

 

 

8. Either accept the defaults or select a drive from the Server Data Drive drop-down list 

and edit the Server Name field to match the name of the Sybase database service. 

Note: When running the install, the SQLMDS parameters can be edited to point to one 

database only. Example: To update the second database, run the update steps again 

and change the parameters to location of the second dataset: 

-n SQLMDS C:\WinOMSCS\Data2\mdsdb2.db -x tcpip 

9. Click Next. The Automatic Administrator Log-in Settings window is displayed. 

 

 

10. Select Use Automatic Administrator Log-in. 

11. The User Name field defaults to the Windows login name. Enter the corresponding 

password. 

Notes: 

• The user must have administrator privileges. 
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• If you do not want to take advantage of the Automatic Administrator Log-in 

feature, you must manually log into the server to run WinOMS. 

12. Click Next. A message is displayed stating the software is ready to be installed. Allow 

the update to run. 

13. Click Finish. A message is displayed stating the server installation is complete. 

 

 

14. Click OK. 

15. Click Exit. 

You can now update the workstations. 

Updating Workstations – v9.x 

To update WinOMS on a workstation: 

1. Navigate to the location of the ISO file. 

2. Right-click the ISO file and select Mount. 

3. Right-click Setup.exe and select Run as administrator. 

Notes: 

• If you have a zipped file of the disk instead of the ISO file, unzip the file. Map a path 

to the CSInstaller folder. Right-click Setup.exe and select Run as administrator. 

• The installer checks the computer for Microsoft .NET Framework 3.5 Service Pack 

1 (SP1). 

o If the files are present, the installation proceeds as usual. 

o If the files are not present, the installation of SP1 proceeds automatically. After 

SP1 is installed, a prompt to restart the computer is displayed. Restart the 

computer. If the installation does not continue after the restart, repeat step 3. 
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o After SP1 is confirmed or installed, the Select Component window is displayed. 

 

 

4. Select Client Side, and I understand that the client side of WinOMS v9.7 only runs 

on Windows 7, 8.1 and 10. 

5. Click Next. The Target Directory window is displayed. 

 

 

6. Either accept the default or edit the path in the Target Directory field. 

o The target directory is the location where the update should be installed. 

7. Click Next. The WinOMS Version 9.7 Update window is displayed. 

8. Click Finish. The Status of WinOMS 9.7 Client Update window is displayed while the 

update is running. A message is displayed when the installation is complete. 

9. Click OK. 

10. Click Exit. 

11. Repeat the steps to update WinOMS on each computer in the network. 
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Installing on a New Server – v9.x 

To install WinOMS, version 9.x, for the first time, on a new server you must install the software 

in the following order: 

1. Install WinOMS on the server. 

2. Install WinOMS on the workstations. 

Installing on a Server – v9.x 

During a new installation, WinOMS files are copied to the hard drive of the server. A new 

installation also installs the Sybase Network Database Server, version 9.7, on the server. 

Note: The Sybase Services cannot be running during a new server install and only installs the 

current version from the Server Side – Install selection. The Sybase Services must be running 

when selecting a Server Side – Update and is run after the install is completed. 

1. Shut down all workstations in the network and close all programs on the server. All users 

must be logged out of WinOMS. 

Note: The server installation requires the Sybase license included in the WinOMS 

software. 

2. Right-click the ISO file and select Mount. 

3. Right-click Setup.exe and select Run as administrator. 

Notes: 

• If you have a zipped file of the disk instead of the ISO file, unzip the file. Map a path 

to the Setup.exe file. Right-click Setup.exe and select Run as administrator. 

• The installer checks the computer for Microsoft .NET Framework 3.5 Service Pack 

1 (SP1). 

o If the files are present, the installation proceeds as usual. 

o If the files are not present, the installation of SP1 proceeds automatically. After 

SP1 is installed, a prompt to restart the computer is displayed. Restart the 

computer. If the installation does not continue after the restart, repeat step 3. 

o After SP1 is confirmed or installed, the Select Component window is displayed. 
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4. Select Server Side – NEW Install. 

5. Click Next. The Server Data Drive window is displayed. 

 

 

6. Either accept the defaults or select a drive from the Server Data Drive drop-down list 

and edit the Server Name field to match the name of the Sybase database service. 

7. Click Next. The Automatic Administrator Log-in Settings window is displayed. 
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8. Select Use Automatic Administrator Log-in. 

9. The User Name field defaults to the Windows login name. Enter the corresponding 

password. 

Notes: 

• The user must have administrator privileges. 

• If you do not want to take advantage of the Automatic Administrator Log-in 

feature, you must manually log into the server to run WinOMS. 

10. Click Next. A message is displayed stating the software is ready to be installed. 

11. Click Finish. A message is displayed stating the install folder must be shared with full 

access to all users. 

12. Navigate to the WinOMSCS folder on the server. Share the folder with full read and 

write permissions. 

13. Return to the message and click OK. The Sybase OEM Network Database Server – 

Welcome window is displayed. 

Note: When installing on a 64-bit operating system, such as Microsoft Windows Server 

2008 64-bit, the Sybase OEM Network windows are not displayed. The Sybase drivers 

are installed, before a prompt to restart the computer is displayed. 

14. Read the information on the Welcome window and click Next. The Sybase OEM 

Network Database Server - Select Components window is displayed. 
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15. By default, all Sybase components are selected. Do not change these selections. Click 

Next. The Sybase OEM Network Database Server - Start Installation window is 

displayed. 

16. Click Next. The Sybase OEM Network Database Server window displays the progress 

of the installation. This window remains open during the Sybase installation. A message 

is displayed when the installation is complete. 

17. Click Finish. A prompt to restart the computer is displayed. 

18. Click OK to restart the computer. After the installation is complete, a prompt to install the 

license file is displayed. 

19. Follow the steps in the Installing the License File section to install the license file. 

20. Follow the steps in the Registering the Software section to register the software. 

Creating a Database Service – Sybase 

After installing WinOMS on the server, you must create a database service in Sybase Central. 

1. Double-click the Sybase Central icon on the desktop. The Sybase Central window is 

displayed. 
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2. Click Adaptive Server Anywhere 9 in the Folders list and click the Services tab in the 

right pane. The New Services Button is displayed above the Folders list. 

3. Click the New Services button. The Create a New Service wizard is displayed. 

 

 

4. Type SQLMDS in the field and click Next. A prompt to select a service type is displayed. 
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5. Select Network Database Server and click Next. 

6. Click Next to accept the default selection. A prompt to specify parameters is displayed. 

7. Type -n SQLMDS (ServerDataDrive):\WinOMSCS\Data\mdsdb.db -x tcpip and click 

Next. 

o Replace (ServerDataDrive) with the server drive letter. 

o A prompt to select the account service is displayed. 

8. Select Local System Account. Ensure the Allow service to interact with desktop 

option is selected and click Next. 

9. Select Automatic and click Next. 

10. Click Finish. The Sybase Central window with the SQLMDS service is displayed. 

 

 

11. Right-click the SQLMDS service and click Start to start the service. A green light is 

displayed before the SQLMDS service name. 

12. Restart the v9.7 update following the steps in the Updating the Server – v9.x – Sybase 

section. 

Installing on a Workstation – v9.x 

Note: The server installation must be complete before installing WinOMS on the workstations. 

Updating v9.x on an Existing Workstation 

1. Verify the server is running. 

2. Log into WinOMS on the workstation. A prompt is displayed stating it has detected a 
new version of the software and asks if you want to update now. 

3. Click Yes to proceed with the update. 

o If the update does not run automatically, follow the steps in the next section to install 
v9.x. 
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Installing v9.x on a New Workstation 

1. Verify the server is running. 

2. Navigate to the location of the ISO file. 

3. Right-click the ISO file and select Mount. 

4. Right-click Setup.exe and select Run as administrator. 

Notes: 

o If you have a zipped file of the disk instead of the ISO file, unzip the file. Map the 
path to the CSInstaller folder. Right-click Setup.exe and select Run as 
administrator. 

o The installer checks the computer for Microsoft .NET Framework 3.5 Service Pack 
1 (SP1). 

▪ If the files are present, the installation proceeds as usual. 

▪ If the files are not present, the installation of SP1 proceeds automatically. After 
SP1 is installed, a prompt to restart the computer is displayed. Restart the 
computer. If the installation does not continue after the restart, repeat step 4. 

After SP1 is confirmed or installed, the Select Component window is displayed. 

 
 

5. Select Client Side, and select I understand that the client side of CS WinOMS v9.7 
only runs on Windows 7, 8.1 and 10. 

6. Click Next. The Target Directory window is displayed. 
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The Target Directory defaults to C:\WinOMSCS\ and should not be changed. 

7. Click Next. The WinOMS Version 9.7 Installation Finish window is displayed. 

8. Click Finish. The Sybase Client Drivers window is displayed. 

9. Enter the server IP address. 

• If you use static IP addresses on the workstation, enter the IP address of the current 

workstation. 

• There will be fields to enter both server IP and workstation IP addresses. 

10. Click Next. The Sybase Client Drivers - Start Installation window is displayed. 

11. Click Next. A message is displayed stating the Sybase client drivers have been 

successfully installed. 

12. Click Finish. The Status Messages window is displayed, indicating the progress of the 

installation. When the installation is complete, a prompt to restart the computer is 

displayed. 

13. Click Yes to restart the computer. After the installation is complete, the WinOMS icon is 

displayed on the desktop. 

14. Repeat the steps to install WinOMS on each computer in the network. 

WinOMS v9 to v10 Conversion – On Premise & Hosted 

Important: The WinOMS v10 update converts the database from a Sybase platform to a 

MSSQL platform and requires an MSSQL license in addition to the WinOMS application. The 

update may be required to use some third-party applications that are only compatible with v10. 

On Premise WinOMS v9.x to v10 Database Conversion 

Do the following steps before performing the WinOMS v9 to v10 conversion. 

• Review the current System Requirements to ensure the hardware and third-party 

applications used in the office are compatible with WinOMS v10. 
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• Review the Database Size Requirements for MSSQL. 

• Review the Installation Guide in the Resource Library for details to configure a 

database migration. 

• Follow the steps in the WinOMS Version 10.x MSSQL Instructions section to install v10. 

Resetting User Passwords After Updating to v10.x 

Important: After converting to WinOMS v10.0, on premise WinOMS users must reset their 
passwords. During the upgrade, you are prompted to set the Admin Password. This temporary 
password must be given to the administrator. The admin user must follow these instructions to 
launch the Restore User Access utility to initiate process of resetting all users’ passwords and 
restoring their WinOMS access. 

To reset user passwords: 

1. Log in as the admin user, using the temporary password set during the upgrade. The 
Restore User Access utility is launched automatically, displaying a list of all active 
users. 

2. Verify the active users in the list. Use the filters and checkboxes to adjust the list as 
needed. 

3. Ensure the Active Users filter is selected and click Select All. The list is highlighted. 

4. Select Reset Password. A confirmation message is displayed: You have selected xx 
out of xx total users. Are you sure you would like to reset the passwords for the 
selected users? 

5. Click Yes. A Process Complete message is displayed, verifying the reset to the 
temporary password. 

6. Provide all users with the temporary password. When they log into WinOMS, they will 
receive a prompt to reset their password. 

Hosted WinOMS v9.x to v10 Conversion and Updates 

• All WinOMS Hosted conversions and updates are performed by the Carestream Dental 
Cloud team. These updates are scheduled on weekends. Check with support to ensure 
any 3rd party service the office is currently using is compatible in v10. 

• Obtain three (3) optional weekends preferred by the client and contact support for 
assistance with scheduling the appointment. The office will not be able to use WinOMS 
during the update and conversion process. Prior to scheduling an appointment, review 
the current System Requirements to ensure the hardware and third-party applications 
used in the office are compatible with WinOMS v10. 

WinOMS v10 Database Size Requirements for MSSQL 

If the database is 7.5 GB or smaller, the customer can be assigned a license for Microsoft SQL 
2019 Express. Once the database increases to 8.5 GB or larger, the customer will be prompted 
to reach out to the sales team to upgrade to Microsoft SQL 2019 Standard. If the database is 
10 GB or larger, Microsoft SQL 2019 Standard is required. 

Determine the current WinOMS database size. Ensure the available free hard drive space on 
the server is at least 3x the size of the database. 
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Important: We recommend contacting our sales team at 800.944.6365 to purchase the 
appropriate Microsoft SQL 2019 license before converting to WinOMS v10. 

How Long Is the SQL Database Conversion for WinOMS v10 

The time needed for converting the WinOMS database from Sybase to SQL is approximately 1 
hour per 10 GB of database size. Example: If the database is 40 GB, the conversion should 
take approximately 4 hours. This time estimate is for the database conversion and server 
update portion of the process only. It does not include the time needed to update the 
workstations. SQL is installed automatically on the workstations as part of the update process. A 
separate SQL installation is not required on the workstations, whereas the server installation 
requires both the SQL and WinOMS update files to be downloaded and installed. See the 
WinOMS Installer Files section for steps on downloading the installation files. 

WinOMS Version 10.x and Higher SQL Instructions 

Important: Before installing or updating WinOMS, we recommend you back up any important 
data and the entire WinOMSCS folder on the server which includes the data files. 

Installing on a New Server – v10.x 

This section includes updating the database from v9 to the new v10 WinOMS database 
platform. All users must be logged out of WinOMS before beginning this process. 

Updating the Database from v9 to v10 

1. The new server must have an existing working copy of WinOMS v9 before starting this 
process. Open Sybase Central on the server, the half gold wheel on the desktop or 
under Windows Services, and verify the SQLMDS service is running. 

Note: If updating on a new server, follow the steps in the Installing on a New Server – 
v9.x and Migrating the Data sections to migrate the Sybase version to the new server 
first before installing MSSQL and the v10 update. 

2. Verify Microsoft .NET 3.5 Framework is installed. 

Note: This information is in Server Manager > Features. A server reboot is required 
after enabling .NET. 

3. Shut down all workstations in the network and close all programs on the server. All users 
must be logged out of WinOMS. 

4. Navigate to the folder where the Installer Files are saved. 

5. Right-click the SQLServerCD 1.4.ISO file and select Run as administrator. A prompt is 
displayed confirming this install is on the server. 

6. Click Yes. The WinOMS Database Installer window is displayed. 

7. If an Activation Code or License is needed, a prompt is displayed to enter the required 
code or license. Use the proper button and follow the prompts. 

8. Click Install. The SQL Server 2019 database is installed on the server. When the 
installation is finished, a prompt is displayed to restart the computer. 

9. Restart the computer. 

Note: If needed, configure the Firewall to open the 1434, 1435, and 1436 ports. 
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10. After the SQL Server installation is complete and the computer has been restarted, 
navigate to the folder where the Installer Files are saved. 

11. Right-click WinOMS(version_number).exe and select Run as administrator. 

Note: The installer checks the computer for the Microsoft .NET Framework 3.5 
Service Pack 1 (SP1). 

o If the files are present, the installation proceeds as usual. 

o If the files are not present, the installation of SP1 proceeds automatically. After SP1 
is installed, a prompt to restart the computer is displayed. If the WinOMS installation 
does not continue after the restart, repeat step 4. 

The installation files are extracted, and the Select Component window is displayed. By 
default, Server Side - Update is selected. 

12. Click Next. The Server Database to Convert window is displayed. 

13. Either accept the defaults on the window, or do one of the following actions: 

o To change the Server Database drive, click the arrow and select a drive from the 
list. 

o To change the Directory, click the ellipsis and browse to the directory. 

o To change the Service Name, edit the field to match the name of the local database 
service. 

14. The Automatic Administrator Log-in Settings window is displayed. Select Use 
Automatic Administrator Log-in. 

Note: If you do not want to take advantage of the Automatic Administrator Log-in 
feature, users must manually log into the server to run WinOMS. The Username field 
defaults to the Windows login name used to log into the server. Enter the corresponding 
Windows login password. The user must have administrator privileges. 

15. Click Next. 

Important: Enter the username and password for the WinOMS admin user. Follow the 
steps in the Resetting User Passwords section to reset passwords and restore access to 
all active WinOMS users. 

16. Click Next. The SQL Server Setup window is displayed, and the software is installed. 

17. When prompted, restart the machine. 

18. Click Finish. The Status of CS WinOMS 10.x Server Update window is displayed. 

o When upgrading to the next major release, such as from 9.x to 10.x, the Release 
Code window is displayed after the status window. Follow the steps in the 
Registering the Software section to register the software. 

Note: If you are unable to register the software at this time, click Cancel to continue with 
the update. You have seven days to register the product. 

The Status of CS WinOMS 10.0 Server Update window is displayed again, showing 
the progress of the installation. A message is displayed stating the server installation is 
complete. 

19. Click OK. 

20. Click Exit. 

You can now update the workstations. 
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Installing on a Workstation – v10.x 

1. Verify the SQL service is running under Windows Services. 

2. Navigate to the folder where the Installer Files are saved. 

3. Right-click WinOMS(version_number).exe and select Run as administrator. A prompt 
is displayed confirming you want to proceed with the install. 

4. Click Yes. The Select Component window is displayed. 

o The installer checks the computer for Microsoft .NET Framework 3.5 Service Pack 
1 (SP1). 

o If the files are present, the installation proceeds as usual. 

o If the files are not present, the installation of SP1 proceeds automatically. After 
SP1 is installed, a prompt to restart the computer is displayed. Restart the 
computer. If the installation does not continue after the restart, repeat step 3. 

5. Select Client Side and I understand that the client side of CS WinOMS v10.0 only 
runs on Windows 8.1 and Windows 10. 

6. Click Next. The Target Directory window is displayed. 

o The target directory is the location where the update should be installed. The 
default target directory is C:\WinOMSCS\. 

o If the default target directory is incorrect, edit the path. For the Server directory, 
click Scan. The installer finds and enters the server directory accessed by the 
client. Or click the ellipsis to browse to and select the directory folder. 

7. Click Next. The WinOMS Version 10.0 Installation window is displayed. 

8. Click Finish. The Status Messages window is displayed indicating the progress of the 
installation. When the installation is complete, a prompt to restart the computer is 
displayed. 

9. Click Yes to restart the computer. After the installation is complete, the WinOMS icon is 
displayed on the desktop. 

10. Repeat the steps to install WinOMS on each computer in the network. 

Updating the Server – v10.x 

The following instructions provide steps for installing a Server Side – Update where the server 
is currently running v10. Example: Updating from v10 to v10.0.3. The instructions are not 
intended for a server migration or new server installation of v10. 

To update the server: 

1. Shut down all workstations in the network and close all programs on the server. All users 
must be logged out of WinOMS. 

2. Ensure the MSSQL service is running. 

3. Ensure the WinOMSCS folder on the server is a shared folder with full read and write 
permissions. 

o Navigate to the WinOMSCS folder on the server. 

o Share the folder with full read and write permissions. 

4. Navigate to the folder where the Installer Files are saved. 

5. Right-click WinOMS(version_number).exe and select Run as administrator. A prompt 
is displayed confirming you want to proceed with the install. 
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6. Click Yes. The Select Component window is displayed. 

 
 

7. Select Server Side – Update. 

 
 

8. Click Next. The default in the Server Data Drive field is the C drive. If data is located on 
a different drive, select the drive from the drop-down list. 

o (Optional) If the office has a dual database setup, after updating the first dataset, run 
the update a second time. Click Change. Edit the Database Name and Server Data 
Drive to update the second dataset. Click Next. 

Example: Add the number 2 at the end of the name of the second database, 
mdsdb2, and change the drive to update the contents in the Data2 folder. 
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9. Click Next. The Automatic Administrator Log-In Settings screen is displayed. 

 
 

10. Select Use Automatic Administrator Log-in. 

11. Type the administrator credentials in the User Name and Password fields. 

12. Click Next. 
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13. Click Finish. 

The update initializes. The SQL services are stopped and started to create a backup. 
The update proceeds after doing several checks and runs through the steps. Some 
steps take longer than others. 

 
 

Let the update run. The Status Messages window is displayed indicating the progress 
of the installation. A message is displayed when the installation is complete. 

14. Click OK. 

 

You can now update the workstations. 
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Updating Workstations – v10.x 

Note: The update can be run on workstations simultaneously. 

The following instructions provide steps for installing a client-side update where the workstation 
is currently running v10. Example: Updating from v10 to v10.0.3. 

1. Log into WinOMS on the workstation. A prompt is displayed stating it has detected a 
new version of the software and asks if you want to update now. 

2. Click Yes to proceed with the update. 

Migrating the Data – v9.x and v9.x to v10.x Update 

• Download the WinOMS install files prior to the scheduled appointment. See the 
WinOMS Installer Files section for steps on downloading the installation files. 

• Confirm the number of databases to be updated using one of the following methods. 

Sybase: 

▪ On the old server, open Parameters in Sybase Central. 

▪ Verify the databases in the ODBC settings. If multiple databases exist, the 
databases will be labeled mdsdb and mdsdb1. 

• If there are multiple databases follow the steps in the Configuring Dual Database 
after a Server Migration – v9.x – Sybase section. 

MSSQL: 

▪ Work with WinOMS support to verify the database locations. 

• If possible, keep the new server name and IP address the same as the old server. 

• If possible, ensure the WinOMS folder on the new server is shared with the same 
name as the old share, usually MDCS or WinOMSCS. 
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• Set sharing and security permissions on the new data folder to Full Control for 
Everyone with full read and write permission. Do the same for Domain users and 
Authenticated Users groups, if used. 

Demoting the Old Server – v9.x 

To demote the old server: 

1. Double-click the Sybase (SQL) Central icon on the desktop. 

2. Double-click Adaptive Server Anywhere 9. 

3. Select the Services tab on the upper-right side of the pane. 

4. Right-click SQLMDS and select Stop. 

5. Right-click SQLMDS and select Properties > General. 

6. Set Startup type to Disabled. 

7. Click OK to save changes and exit Sybase Central. 

8. Right-click the PracticeWorks Server icon (gold key) in the task bar and select Exit 
PracticeWorks Server. 

9. Copy the license files pwlf.dat and store it on the desktop of the new server. Rename 
the PracticeWorks Server icon. The license file is located in the PWSvr folder. 

o Open the PWSvr directory on the server, for example, F:\WinOMSCS\PWSvr. 
Rename the pwsvr.exe file to pwsvr.exe_OLD. 

10. Locate the PWSvr and MDCSRegistered folders in the WinOMSCS folder on the server 
and rename them to PWSvr_OLD and MDCSRegistered_OLD. 

11. Copy the entire WinOMSCS folder from the OLD SERVER to the NEW SERVER. The 
WinOMSCS folder MUST be on the root of the drive, for example, E:\WinOMSCS\. 

12. Turn off the old server or remove the server from the network. 

Promoting the New Server – v9.x 

To promote the new server: 

1. Share the WinOMSCS folder copied from the old server. Use the same share name that 
was used on the old server, usually WinOMSCS or MDCS. 

2. Set the Sharing and Security permissions on the WinOMSCS or MDCS folder as 
follows: 

o Set permissions for Everyone to Full Control. 

o If Domain Users or Authenticated Users Groups are used, set permissions to Full 
Control. 

3. Ensure .NET 3.5 Framework in Server Manager > Features is enabled. 

o A reboot is required after .NET 3.5 Framework is installed or enabled. 

4. Install WinOMS as per the instructions in the Installing on a Server – v9.x section. 

5. After the computer restarts during the installation, click OK on the prompt stating the 
mdsdb file is present. This step ensures the data WILL NOT be overwritten. 

6. When the Server-Side install is complete, configure the Sybase SQLMDS Service and 
start the database service following the steps in the Configuring Sybase Services – v9.x 
section. If an error is generated when starting the SQLMDS service, follow the steps in 
the Unknown Error Starting SQL Service in Sybase section to resolve the issue. 
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Note: If the client uses ePrescriptions, follow the steps in the Configuring 
ePrescriptions During a Server Swap – v9.x section to configure the service on the new 
server. 

7. Verify the PracticeWorks Server icon (gold key) is running in the system tray. 

o If the gold key is not running, make sure the PWClient path on the server is set to a 
drive letter path. Follow the steps to set the path in the Updating the PWClient 
License Path section, then double-click the PWSvr.exe file to launch. 

8. If the name of the new server is different from the old server, run the cstoolkit utility to 
update the server directory. Follow the steps in the Updating the Server Directory Using 
CSToolkit section. 

9. Add an exception for any software or hardware firewalls. The file to be excluded or 
allowed is the dbsrv9.exe located at: 

o On 32-bit operating systems: 

i. C:\Program Files\Sybase\SQL Anywhere 9\win32\dbsrv9.exe 

o On 64-bit operating systems: 

i. C:\Program Files\Sybase\SQL Anywhere 9\x64\dbsrv9.exe 

10. Configure the firewall to open the 2638 port for UDP. 

11. If updating the software version as well as installing the new server, run the update 
again to update the database to the current version installed on the server. Follow the 
steps in the Updating the Server – v9.x – Sybase section. 

12. Configure nightly backups for the new server. 

Notes: 

o WE DO NOT SUPPORT LIVE BACKUPS. 

o The Sybase SQL service for the database is REQUIRED to be STOPPED to ensure 
a valid copy of the database is made during backup process. 

o Online backup services are supported as long as the Sybase SQL service is 
STOPPED prior to the backup initiating. 

o Follow the steps in the Configuring the Backup for WinOMS v9.7 and Older – Sybase 
section to stop and start the database service. 

Install Client Side on Server – v9.x 

1. Navigate to the location of the ISO file. 

2. Right-click Setup.exe and select Run As Administrator. 

3. Select Client Side, and I understand that the client side of WinOMS v9.7 only runs 
on Windows 7, 8.1 and 10. 

4. Click Next. 

5. Select the drive path where the Server Side was installed, for example, 
D:\WinOMSCS\. 

6. Click Finish. 

7. After the installation is complete, log into WinOMS to test. 
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Configuring Workstations after a Server Migration – v9.x 

• If the name of the new server is different than the old server, the PWClient path for all 
workstations must be updated. Follow the steps in the Updating the PWClient License 
Path section. 

• If the practice has remote office locations connecting to the server via VPN, 
update the server IP address in the ODBC data connection on the remote 
workstations. 

o On a 32-bit workstation: 

i. Verify the TCP/IP option is selected in Control Panel > Administrative Tools 
> Data Sources (ODBC) > System DSN tab > Configure MDCS > Network 
tab. 

ii. Type Host=xxx.xxx.xxx.xxx in the field, where X is the static IP address to the 
WinOMSCS folder on the server. 

o On a 64-bit workstation: 

i. Navigate to C:\Windows\SysWow64\Odbcad32.exe. 

ii. Verify the TCP/IP option is selected in Control Panel > Administrative Tools 
> Data Sources (ODBC) > System DSN tab > Configure MDCS > Network 
tab. 

iii. Type Host=xxx.xxx.xxx.xxx in the field, where X is the static IP address to the 
WinOMSCS folder on the server. 

Configuring Sybase Services after a Server Migration – v9.x 

1. Double-click the Sybase Central or SQL Central icon on the desktop. 

2. Double-click Adaptive Server Anywhere 9. 

3. Select the Services tab. 

o If SQLMDS is listed in the services, verify it has a green light. 

o If SQLMDS is not listed in the services, continue to the next steps. 

4. Select File > New Service. 

5. Type SQLMDS in the field and click Next. 

6. Select Network Database Server and click Next. 

7. Confirm the Sybase executable path is correct for the operating system on the server. 

o For 32-bit: C:\Program Files\Sybase\SQL Anywhere 9\win32\dbsrv9.exe 

o For 64-bit: C:\Program Files\Sybase\SQL Anywhere 9\x64\dbsrv9.exe 

8. Type -n SQLMDS (ServerDataDrive):\WinOMSCS\Data\mdsdb.db -x tcpip in the 
Parameters field. 

o Replace (ServerDataDrive) with the server drive letter. 

Note: Complete steps 9 and 10 only if the client uses ePrescriptions. If the client does 
not use ePrescriptions, skip to step 11. 

9. Click the end of the SQLMDS WinOMS string and press Enter to drop to the next line. 

10. Type -xs http (port=8081) on the new line. Do not cut and paste. The string must be 
entered manually. 

11. Select both the Local System Account and Allow service to interact with desktop 
options. 

12. Select Automatic Startup. 
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13. Select Start services now. 

14. Click Finish. The SQLMDS service is now running. A green light is displayed before the 
SQLMDS service name. 

Configuring Dual Database after a Server Migration – v9.x 

1. Verify everyone is logged out of each WinOMS database before doing a server 
migration. 

2. Verify the number of databases to be transferred to the new server. 

3. If the old server is accessible, verify the ODBC settings for each database. These 
settings can be used to configure the ODBC settings on the new server. 

4. Verify each database is included in the Sybase Central parameters. 

o When updating, verify all databases are updated to the same version. 

Example: If updating from v9.6 to v9.7, verify all databases are updated to the same 
version before continuing to work in WinOMS. 

o The first time the update is run, the first database, mdsdb, is updated. Run the install 
a second time. During the install, click the ellipses. Then navigate to and select the 
Data2 directory in the Target Directory field to update the second database, 
mdsdb2. 

 
 

5. Ensure a copy of each database is accessible on the new server. 

6. Each database will have its own license file. Transfer the license files to the new server. 
Contact support for the licenses, if replacement files are needed. 

7. After completing the migration, test logging into WinOMS for each database. 

Follow the instructions in the next sections to configure the ODBC and Registry edits required 
on the new server after a server migration when using multiple databases. 

Licensing for Dual Databases – v 9.x 

In a dual database configuration, each database is required to have its own license file. This 
section covers the steps for configuring files for the second database. 

1. Stop the service SQLMDS. 

2. Create a new folder on the server named Data2; for example, C:\WinOMSCS\Data2. 

3. Copy the new database to the Data2 folder; for example, mdsdb2.db. 

4. Open Sybase Central from the desktop. 

5. Go to the Services tab. 

6. Right-click SQLMDS (service name) and select Properties. 

7. Click the Configuration tab. 

8. Edit the parameters to add the path to the second database. Example: Type  

-n SQLMDS c:\WinOMSCS\Data\mdsdb –x tcpip c:\WinOMSCS\Data2\mdsdb2. 

9. Click Save. 

10. Change the Log File setting in Sybase Central. 
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• Go to Tools > Adaptive Server 9 > Change Log File Settings. 

• Browse to mdsdb2 on the server. 

• Accept all default settings. 

• Set the path for the log file to c:\WinOMSCS\Data2\mdsdb2.log. 

11. Start the service SQLMDS. 

Installing the License File – v9.x 

1. Copy the license file into the PWSvr folder. 

• If the office has a dual database setup, copy the license file for each database into 
the PWSvr folder in the Data and Data2 folders. 

2. Open the PracticeWorks server and note the ID numbers. 

3. Go to Start > Run and type regedit. 

4. Go to HKEY_LOCAL_MACHINE > Software > PracticeWorks. 

5. Right-click PWRegSvrLicFileID. 

6. Select Modify. 

7. Set Value to 1. 

Note: This is the ID number for the first database. Complete the following for the second 
database license file. 

8. Right-click the PracticeWorks folder under HKEY_LOCAL_MACHINE > Software. 

9. Click New. 

10. Select String Value which adds an entry in the right window. 

11. Rename the new entry to PWRegSvrLicFileID. 

12. Right-click the new PWRegSvrLicFileID entry. 

13. Select Modify. 

14. Set Value to 2. 

15. Close the Registry. 

16. Log into each instance of WinOMS to test. 

Creating Registry Edits 

Perform the following steps while still in the Registry Editor: 

1. Open HKEY_LOCAL_MACHINE > Software > PracticeWorks. 

2. Highlight the PracticeWorks key and export it to the desktop with a name to identify the 
registry settings for the first database, for example, database1. 

3. Go back to HKEY_LOCAL_MACHINE > Software > PracticeWorks. 

4. Change the DSN to mdcs2. 

5. Modify the PWRegSvrLicFileID value to equal 2 and export it to the desktop with a 
name to identify the registry settings for the second database, for example, database2. 
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Configuring ODBC Settings 

1. Go to Start > Settings > Control Panel > Administrative Tools > Data Sources 
(ODBC). 

2. Click the System DSN tab. 

3. Click Add. 

4. Create a data source named mdcs2. 

5. Configure the ODBC to show the second database name under the Database tab. 

6. When the migration is completed, double-click the registry export on the desktop for the 
first database. Then double-click on the WinOMS icon to log into the software. 

7. Log out of the first dataset. 

8. Double-click the registry export on the desktop for the second database. Then double-
click on the WinOMS icon to log into the software.to access the second dataset. 

Configuration and Error Messages Associated with Server 
Migrations and New Server Installations – v9.x 

Unknown Error Starting SQL Service in Sybase 

When trying to start the database service, an error message is displayed stating, the service 
‘SQLMDS’ has generated an unknown error. This error is generated when the path to the 
mdsdb.log file is incorrect in Sybase. 

1. Open Sybase Central. 

2. Click the Utilities tab. 

3. Select Change log file settings. 

4. Click Next. 

5. Browse to the database file, (ServerDataDrive):\WinOMSCS\Data\mdsdb.db. 

6. Highlight the file and click Open. 

7. Click Next. 

8. Note the log file path, if the drive letter is incorrect. 

9. Click Next. 

10. Verify the Maintain the following transaction log file option is selected. 

11. Correct the log file path drive letter. The drive letter can be verified in the Sybase 
Central configuration on the desktop of the new server. 

12. Click Next. 

13. Verify the Maintain the following mirror log file option is NOT selected. 

14. Click Next. 

15. Accept the defaults. 

16. Click Finish. 

Updating the Server Directory Using CSToolkit 

1. Launch the cstoolkit.exe in the root of the WinOMSCS folder, 
(ServerDataDrive):\WinOMSCS\cstoolkit.exe. 

2. Select the first option, Server Directory Assignment Tool. 
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3. Click the green arrow. 

4. Select the practice name from the drop-down list. 

5. Enter the correct UNC path to the WinOMSCS directory; for example, 
\\Server\WinOMSCS\. 

6. Click Apply. 

7. Click OK. 

Updating the PWClient License Path 

1. Open PWClient. 

o On 32-bit operating systems: Go to Start > Run. Type PWClient. 

o On 64-bit operating systems: Go to C:\Windows\SysWow64\PWClient.exe. 

2. Click Options. 

3. Set the path. 

o On the server ONLY, set to driver letter path to PWSvr.exe, 
(ServerDataDrive):\WinOMSCS\PWSvr\. 

o On the workstations, set the path to the new UNC path to the gold key on the server; 
for example, \\Server\MDCS\PWSvr\. 

4. Click OK. 

5. Click Close. 

6. Log into WinOMS. 

Third Party Products 

WinOMS integrates with multiple third-party vendors. As such, some configuration for clients 
that use these products may be required. 

Note: This listing is not a complete list of third-party integrated products used by the office. It is 
used to aid with the most common issues. For a more comprehensive list of third-party products 
integrated with the software, see the System Requirements. 

Related Documentation and Resources 

Additional information available in the Resource Library: 

• Initial Training Workbook 

• Online Help 

• Release Notes 

• Link to our virtual agent, Cassidy 

o https://gosensei.com/pages/support-winoms 

Cassidy is Carestream Dental’s AI-powered virtual agent offering 24/7/365 online customer 
support. When you need a quick step-by-step guide or question on product needs, information 
is instantly available via Cassidy. 

https://gosensei.com/pages/resource-library
https://gosensei.com/pages/support-winoms

